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Introduction

This document describes how to migrate from the High-performance Embedded Workshop for
R8C,M16C Family to CubeSuite+ for RL78 and how to operate E1 and E20 emulators in the
CubeSuite+ environment, this explanation is based on CubeSuite+ V1.02.00.

For toolchains, refer to the following three materials.

- Integrated Development Environment for RL78 Family Migration to Integrated Development
Environment “CubeSuite+”: Build,.

- Integrated Development Environment for RL78 Family Migration to Integrated Development
Environment “CubeSuite+”: Coding,.

- Integrated Development Environment for RL78 Family Migration to Integrated Development
Environment “CubeSuite+”: Starting,.

Also refer to the tutorial guide provided by CubeSuite+ for how to use tools.

The tutorial guide is available by selecting [Help] -> [Tutorial] from the CubeSuite+ menu.

E? CubeSuite+ Help =13

Hoe 2 &

Hide  Back Forward  Fiin

z -~
LContents | Search

LT ~|| Introduction

@ 70K0
& 7EKIR

250 CubeSuite+

Welcome to the world of development environment

@ Oveniew ! CubeSuite+.
@ Start : e .
@ Cording This tutorial introduces you to the integrated development
@ Debug environment provided by CubeSuite+ and operation of
& wite CubeSuite+. By carrying out all the steps described in this
@ ppendis tutorial, from creating a program to debugging to the
@ TRKD [with CATRKD VI 21] . ; . .
< | > microcontroller. vou can easilv experience the operation of ! v

Tutorial Guide
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1. Integrated Development Environment and Emulators

R8C,M16C

- High-performance
' Embedded
WOrkshop“'

RL78

CubeSuite+

A new integrated development

Integrated
Development
Environment

(IDE) High-performance environment that supports 8- to 32-bit
Embedded Workshop MCUs from Renesas
On-chip = Provides basic debugging functions
DebussEs \/ E8a(R8C,M16C) at a low price
(OCD) & e e
o i

.- E1(R8C)

High-performance full-spec. emulators

Full-spec.
CPE with more advanced debugging functions

Emulators* (R8C,M16C)

E100
(R8C,M16C)

&

*This document describes about On-chip Debuggers.
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2. Differences between the Target Interfaces (for OCD)

14-pin user system interface cable

14-pin type connector

The RL78 and E1 emulator are connectable via the 14-pin connectors listed

below.

Type Mumber Manufacturer Specification
14-pin TE14-6002 Sumitormo 3M Limited 14-pin straight type (Japan)
connector 2514-6002 AM Limibed 14-pin straight type {other countries)

User system

Although these are the same connectors as for the E8a and
E1/E20 for R8C and M16C products, the communications interface is

different.
— — . The E1 (for RL78) communicates via a single line.
T T |_ Pulled up at 4. Tk0Q or more -“'
o :j MIBC
{ T 1 | y o
5 TPE | . . . =
o | [ _~The E8a (for M16C) is connected via seven lines. 1T | ( RLU78
o e ry 2 S o eration votags for TOOLD ! "
1Pe7 | eNp F——— | L. __— . i
1., — REUFE—%¢ Target Device b
- [F=ri ] REyS— . - =10 - j_
5 [
ce P men ToOLD - ] . ToOLD
HEC reuft ¢ |
Chves | } (| L} =] 0
cu&w o [TV ] Vo = e
% * i [ Putsd up w4700 nL. | i o
Joer - Pulisdd Lp 140 RESET_OUTH™ RESET
RESET# [ RESET® | H 5:.—"; RELU. " v
ves 12 Mota?
Fulled up at é“ Pulled down at GhD 13 ’ Reset ciroult
\ 4.7kQ or more 740 or mone — [ RESET QUTH™ ” RESET signal
E8a Connecting *: Open-collector buffer = — S GHD —— Ves [
Connector ; L - e
= User system L E,.'] IE_D-‘[ . 7_I_,_ 1
A l" T
/ '-lu—| | Pulisd up o 4. Tidl or mare |

: o : The circuits for connection also vary with the MCU. For
The E8 E1/E20 (for R8C ted le line.
eEeaor (for |) 'S connecuim\‘:f SINSIS mel details, refer to E1/E20 Emulator Additional Document

for User's Manual iNotes on Connecting RL 78?.




3.Changing the Debugger

The HEW allowed users to select a debugger (E8a,E1/E20 emulator or simulator)
in the process of changing the debug session or the target shown in the [Debug
Settings] dialog box. The CubeSuite+, on the other hand, allows users to select a
debugger on the project tree. The procedure to change the debugger is described

on the following pages.

High-performance auw
Embedded
Workshop4

|Debug €| SessionRBC_EBa_SYST v

= \\ Target
[E—r P, RaC EBa SYSTEM D

Coni_|

Selecting a Debugger (E8a,E1/E20 Emulator or Simulator) in the HEW
RENESAS




3. Changing the Debugger

(1) The debug tool name (debug tool) on the project tree panel indicates the
currently selected debugger.
The following example shows that the E1 Emulator is selected:

CubeSuite+

Ee\lected debuggeﬂ

/
4, CATEKOM (Bud Tool
&AL T8 EliSerial) (Debug Tool) P
CEProgram Anakyzer (Anabyze Tool)

§ gD T




3. Changing the Debugger

(2) To change the debugger, right-click the debug tool name (debug tool) to
open a pop-up menu. Select [Using Debug Tool] from the pop-up menu to

select the debug tool you want to use.

N +
. Cb'te CER Select the debug tool
- T T Y Y s gnght -click you Want to use.
: FL"_Ell Serial) IE'_,”_-.- i DN Clock Output/Buzz

e Program Anakyzer (ﬂma

_.._m—-——v = - -
o pu— I ;“
& it e prap— i ] e e s (e
i= \ =] _j!l File i Property L Ao ELLSENE])
[y pe—
: S startup RL7S E20(Serial)

F A HoeEE
"




4. Entering an ID Code

Both the R8C/M16C and RL78 require entering of an ID code.
However, there are some differences regarding the setting and authentication of the ID code and the
action that is taken if the ID code does not match.

building.

option byte*

ID code size Address of | Setting the ID | Authenticating the ID Action Taken Valid for the
the ID Code Code When the ID On-board
Code Code Does Not | Programmer?
Match
R8C 7 bytes OxFFDF, Embed the When all ID is FFh, It A debugger is Yes
M16C OxFFES3, code in the is authenticated not started ( the
OxFFEB, user program | automatically at a contents of the
OxFFEF, when debugger start-up, and | flash memory
OxFFF3, building. when other, enter ID are held ).
OxFFF7, into a dialog.
OxFFFB
RL78 10 bytes 0xC4 to Embed the Enter an ID code for Depends on the | No (only valid
0xCD code in the the debugger in setting of the during
user program | advance. on-chip debugging)
when debugging

For details, see E1/E20 Emulator Additional Document for User's Manual (Notes on Connecting RL78).
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4. Entering an ID Code

In the HEW, the [ID Code verification] dialog box opens at startup if an ID code
has been written in the MCU. In CubeSuite+, on the other hand, an ID code must
be set on the [Property] panel before the emulator is started up.

Set an ID code by referring to the following figures:

. © CubeSuite+
High-performance
Embedded

4 -
Sonshoy 2 RL7E E1({Serial) Properiy
B 12 Internal ROMFAM
Il Code werification : r
Pleaze inpui 1he ID code beng weitten i the flash memory. o
D Code: 12 Clock
HEE |D1 D=la04050a07 kain clock freguency [kMHz] IJsing internal clock
Sub clock freguency[kHz] Ising internal clock
[0 bkt konitor clock System
" Hex : Specify ID code by heradecimal 14 digite. |€ Connection with Targel Board
GG : Spesify 1D code by ASGI character within 7 letifrs. Communication method 1line type (TOOLD)
Fower tergel from the emulator (Mas 200ma) Yes
Supphy voltoge 5.0v
E Flash
Security 1D [*] DoODODDOODODDODODOOD
. e =LA R RnE = ) ) T
Example- Usewida waltage mode as
[ID Code] dialog box of the E8a for the R8C Eraegifizsh ROk ehen saning L2
Securty ID
Sets the security ID (20 digits in hexadedmal) for reading the code in the internal BOM or internal flash memone.
For details gn securily ID authentication, see the Emulatar user's manual.

l'ﬂcirjrjééﬁéé_ﬁff )| Cebug Tod Settings | Dowrload File Settngs | Hook Transacton Settings |

-
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5. Securing Resources

When in use with the RL78, OCD takes up some user resources. These areas
should not be used by the user program so keep them reserved (e.g. by using

the build tool).
Reserved areas to be used by E1/E20 (RL78)*

ezl RO =paca

512 bdes o
B bt Mebe s

10 bwbes

10 bytas

1 bt

2 ke

Mok 1

Motz 1. 10 debugging, resetvector is rewritlen 1o address alloczied 10 3 monifor program.
2t en the pseuda BRI furction and Db function 1= not used | #will be 256 bytes

Interna| AOM =rd sddress

4— {a) Debug monilor asa

0aH

a— 1) Debuz moniior amsa

CEH

— oeourity I area
C4H

Cr-chip debue option byle ares
é‘eﬁ | L

44— {2} Debug monilor asa
02H

0lH

Fiemal FaM zpace

4 birmz Wt

4. When the sef prosramming & esecuted, # will be 12 bries

Fiermal Bl end addresc

+— [pStack ares for debugene

For how to allocate resources
through CubeSuite+, see the next

page.

Comparison with the R8C and M16C

RL78

*For details, see E1/E20 Emulator Additional Document

for User's Manual (Notes on Connecting RL78).

(E1/E20)

and some vectors

See the figure at
left.

Does OCD Size What Should be

Take up Used to Allocate

Resources? the User

Resources?

R8C Yes Up to Build tool
(E8a/E1/E20) | (depending 2 Kbytes of ROM, | (setting up the

on the 8 bytes of stack, linkage editor to

MCU) and some vectors | avoid the areas
M16C Yes Up to L‘;%’CtaDk)e” up
(E8a) (depending 2 Kbytes of ROM,

on the 128 bytes of RAM,

MCU) 14bytes of stack,

Build tool
(through the GUI
of CubeSuite+)
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5. Securing Resources

The address of the area for monitoring by the debugger can be specified on
the [Link Options] sheet of the [Property] panel of the build tool.

CubeSuite+

: @ 2 4, CATBKOR Proparty
& Timer = | E Debug Information
= Watchdog Timer b A det_:ug information Yes
) B Input File
- Real-time Clock TR
& Interval Timer =] Cl.utput File
% Clock Output/Buzzer Cutput Output folder %BuildModeNarme
= DMA Controller Output file name %ProjectMame %, Imf
i Force linking against error Mo
CATEKOR. (Build Tool) 'E]i:E
»-H“ RL78 E1{Serial) (Debug Tool) _Use onschipaiahu Yes(-go)
2 Program Analyzer (Analyze Toaol) Option byte values for OCD [ 84
= :—EI!'_F_UE Dehug manitar area start address FEOO
Y Startup Debud monitor ares sjizelbwie] 512
=1 code Generator =et user aption byte Yes(-gb)
& F_main.c Uzer option byte value EFFFEDB
& r_systeminit.c Specify mirrar area bt =0(-mid)
&, cge.c et flash start address _ Mo
5 r_-:: Boot area IDaq module file name
= r_cge_Lser.c Control allocation to self RAM area Mo
] r_port.c Message
& r _port_user.c Stack
&l r_timer.c T —
& r_timer_user.c i i
n r_og_macradriver.h
U r_cg_userdefine.h + |\ commona... [Compie Op... [ Assemble... T Link Dpti?." OMization... | ObjectCon... | Va




6. Setting the On-Chip Debugging Option Byte

The on-chip debugging option byte can be set on the [Link Options] sheet of
the [Property] panel of the build tool.

CubeSuite+

: @ 2 4, CATBKOR Proparty
& Timer "‘l = DEhugInfu.mlﬂIiun.
= Watchdog Timer A det_:ug information Yes
) B Input File
& Real-time Clock AT
o Interval Timer E Output File
% Clock Output/Buzzer Cutput Output folder %BuildModeNarme
= DMA Controller Output file name %ProjectMame %, Imf
Force linking against error Mo
Library
B Device
“\ =2 on-chin debua Yes(-aol
2 Program Analyzer (Analyze Toaol) Option byte values for OCD [F] B4
= '.T'_F_i!e " Debug monitor area start address "¢ FEOD
LB Startup Debug monitor area size[byte] a1z
=1L Code Generator set user option byte Yes(-gb)
& F_main.c Uaer.optio.n bvte value EFFFEB
& r_systeminit.c Specify mirrar area bt =0(-mid)
&] et flash start address Mo
6 F_cge.c Boot area load module file name
-—i r_cgc_user.c Control allocation to self RAM area Mo
] r_port.c Message
& p _port_user.c Stack
&l r_timer.c L3 T_th =
& r_timer_user.c Lt
n r_cg_macrodriver.h
U r_cg_userdefine.h + |\ commona... [Compie Op... | Assemble..C_Link Opti... JROMzation... | ObjectCon... | ¥a




7. Where Do We Make Settings when Connecting an Emulator?

In the HEW, the [Emulator Setting] dialog boxes open to make settings when
connecting an emulator. In the CubeSuite+, on the other hand, you need to
make settings on the [Property] panel before connecting an emulator by taking
the following procedure.

Double-click the debug tool name (debug tool) on the [Project Tree] panel to

open the Properties window of the debug tool.
CubeSuite+

rra - CubeSustes - [P fus

"
1 =i |
Fie Fo Wew Propsct Ruld Debisg Tom Windea Hep .
LB s 00 s + LA WO B E Double-click
& g i ]
Pt Tion s | = gy - W
[ I R Srmiia -
- - 5 T
FEF e B PP (Pl oo vk |
; CCAY T I
[Fot it dietmsg B | A o

e G o 4, CA7EK] A (Build Tool)
&l et E o F : o : - Y— -
dom feemmm & RL78 EL(eridl) (Debug TodP
j:.ﬁ ——— | "< Program Analyzer (Analyze Tool)

s [ISCORMECT




7.Where Do We Make Settings when Connecting an Emulator?

In the case of HEW, settings required for connection are made in the [Emulator Setting]
dialog box during the process of connecting the emulator. In the case of CubeSuite+, on
the other hand, these settings must be made in the [Property] panel of the debugger before

connecting the emulator.
(1) The [Emulator Setting] dialog box of HEW corresponds to the [Connect Settings] tab of

CUbeSUite+. Higlé-p:;l‘:;:n;nce CUbESUitE"'
- Workshop* &4 RL7E E1(Serial) Property

. 12 Imernal ROMMPAA
Emulator Setting .

 Emulator made Punare Location | Gommunication Baud Rate | i
MCU Grdup  |RBGA35A Group -1 |5 Clock
=] min clock frequency [MHz) Lzing intamal clack
Device JIREF21356A E | Sub clock frequency[kHz] Using intemal dack
Monitor clock Syetarm
Mode {+ Eraze Flazh and Caonnect |E Connectionwith Target Board Some functlons
e e e o G Communication method 1 lina type (TOOLD) A i
B 2 rFawar target fram the emulator. (kec Z00ma) Tes |nCIUd|ng power
" Program Flagh Al\: Sunphy volage 5.0V supply are
" Debueeing of GPL rewrite mode v = Flash
= correspondent.
R Sacuty 1D T
e g Sl e Parmit flash programming VCE
Use wide voliage mode Yes
Pawer supply Erase flash FROM whan stating Mo
v Power Target from Emulator. (MAX 300mA)
ey fe gl Security I
Sele lhe security 1D {20 digits in hexadecimal) for reading the coda in the internal ROM ar inlernal llash mamorn,.
For getails on sacurity ID authertication, saa the Emulator user's manual

) DebugTosiSettings | Cownload File Settings | Mook Transaction Settngs | =

k] Ganeel |

[ Do not show this dialog box aeain.

Example: On CubeSuite+, the device needs to be selected during the

[Emulator Setting] dialog box of the E8a for the R8C irocess of Creatini a iro-‘ect_
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7. Where Do We Make Settings when Connecting an Emulator?

(2) [Configuration] dialog box of the HEW corresponds to the [Debug Tool
Settings] tab of the CubeSuite+.

High-performance
Embedded
Worl(shop‘

Configuration

General

X

Device [Ferz1350
Ermulation moce | mormal ﬂ
Elash memory [Disahle =
synchionization )

Ok | Cancal |

Example:

[Configuration] dialog box of the E8a for the R8C

CubeSuite+

=% RL78 E1{Serial) Property

B Memory

bermory mappings
Yerity on writing to memory

E Access Memory While Bunning
Access by stopping execution
Update display during the execution
Display update interval[ms]

Break

B Maskfor Input Signal
bask TARGET RESET signal
basgk INTERNAL RESET signal

Break

[9]
Yes

“ag
“'as
500

Mo
Mo

Connect Settings

" Debug Tool Settings )

Download File S

RENESAS




8. Connecting an Emulator

Select [Debug] -> [Connect to Debug Tool] from the CubeSuite+ menu to
establish connection to the selected emulator (debug tool).

Upon completion of the connection, the debug tool name appears on the
status bar at the bottom right of the window.

3
CubeSuite+
@ demo - CubeSuite+ - | 2ropert ] . .
. S Build | Debug | Tool  Window Help
%y Download > EHE A R @® 3" sEE %= Jh 5
1l ) Build & Dowroad _|1-!r DDwnlnad
[== canne bug Teel = p
e - = & @ Build & Download F&
Specify the D code a3 a 32-digh hexadecimal — !
% :E;;FFFFFFFFFFFFFFFFFFFFFFFFFFFF cgnnnect t|:| DE.'I:II_lg @
[ ode )
T =5 Hot Plug-in \
r 4 Select [Connect to
—
] : Debug Tool].
mation_den| | Extenal I flash definition fle ) \
This is a list of the registered files. Sel the [..] b dd an | flash defi fil he dialog b
Download File Settings (  Hook Transackion Settings -
========== Ended(Success:l Projects, Failed:0 Projects)(Tuesday, April 10, 2012 2:46:52 AM) ==========: z FE
Before connection CDK!JDISCONDE':T
17130, .
| After con nectlon
R Step Over [ FTSte
< | 3 ||\ anMessages " Euid Toal = UXFFFFBDDE o RLTE E1 {SE“;DQI
F? Open Hel. [F2 =] ™ |]F5 & Build & D.. |FTBuild Proj.. FE T T T e
erforms the o the: debug kool and starts debuaging. F uuuuuuuuuuuuu

Note If an ID code has been written in the MCU, set an ID code in advance according
to “2. Entering an ID Code.”
= RENESAS




9. Disconnecting the Emulator

To disconnect the emulator, select [Disconnect from Debug Tool] from the
menu or click the | i, | button on the debug toolbar.

CubeSuite+

Debug | Tool ‘Window  Help

j;, Diawnload

@, Build & Download F&

¥ |
Inl
¥
Inl
|
&)

0

3" Upload... - g e W

Disconneck from Debug TID Shift+Fa&

[Disconnect from
Debug Tool]
button
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10. Downloading a Program

Selecting [Debug] -> [Download] from the menu or clicking the | = | button on
the debug toolbar starts downloading specified files.

Selecting [Debug] -> [Build & Download] from the menu or clicking the| &3
button on the debug toolbar builds a project and then starts downloading the
specified files.

If no debug tool is connected, CubeSuite+ connect debug tool automatically
before downloading.

‘ Download

CubeSuite+

Cebug | Tool Window Help

_-h" D-:uwnl-:ua-:l>
K éuild 2 Download > F&

=0 Conneck to Debug Tool

=5 Hok Plug-in .:: % | S

Build & Download j

RENESAS

]




11. Registering Additional Download Files

Add download files in the [Download File Settings] sheet on the [Property] panel.
(1) Select [Download files] and click [...] button on the right.
(2) The [Download Files] dialog box opens. Click the [Add] button.

‘ Select [Download files] and click [...].

CubeSuite+

Download Files

|E57 Property | Heztc \ D avwnload file list: Download file property:

L 5

== RBL78 E1(Serial) Property B Download file information
B Download

1l

(0] DebughB2T.abs Download chiect  Yes
CPU Reset after download Tes Dowrload symbol inl Yes
Eraze flgsh ROM before download . - Mo Specify the FIC/FID Mo
Automatic change method of event setting pozition Suspend event

= Debug Information
Execute to the specified symbal after CPU Reset ez
Specified sprmbal _main

Download files

Specifies the file to be downloaded. The download file dialog bow iz opened by preszing the [...] button, In the
download file dialog box, specify the file to be downloaded.

| Connect Settings ,{’1 Debug Tool Settings <E Download File Settings !>H00kTransacti0n Settings _/{=

File
Specify the file to be downloaded.

| ok H e ][ Help ]

Elic/k[Add] button.




11. Registering Additional Download Files

(3) Specify the file name and file type in the [Download file information] field
and then click the [OK] button.

Download Files le

Download file list; Download file property:

| 62T .abs

E Download hle information

File tupe Load madule file
Dowrload object Ve

load zymbol infarmation Y'es

Specify download file
and file type.

FID qffzet f

Use these buttons to
File select download order.

Specify the file to be downloaded.

— [ Click [OK] button.
DKD| Cancel ‘I Help II [ ] ’

| add || Remove |

Note: When downloading is performed, all of the registered files are downloaded.
To download only desired files, set [Download object] and [Download symbol
information] to “Yes” in this window only for files you want to download.
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11. Registering Additional Download Files

(4) The available file formats (extensions) for the RBC/M16C and for the RL78

are not the same. For details, see the table below.

Load Module Format | Hexadecimal File Binary File
R8C/M16C *x30 *.abs *.mot *.hex *.bin
RL78 * Imf *_.hex *.bin
Purpose To be downloaded for | To be used for Data file

source-level
debugging

writing by a ROM
programmer, etc.




12. Starting/Stopping a Program

You can start or stop a program and reset the CPU from the menu or toolbar
in the same way as the HEW (see below).

CubeSuite+

CubeSuite+ menu

5 MTDN Window  Help
;:": _nb';g, Download
zh.-- @ Build & Download Fa
4 =
":-I —: &% Upload...
5t Disconnect from Debug Tool Shift+Fé
Stmmrics a
Y e e —— ) Go Fs
— Step OUt I[::_-.I Ignore Break and Go Fa
Stop [Step over 5= StepIn Fi1
= Step Cver F10
= Return Out shift-+F11
_'4 an i Ix_,p'l D" Hll =5 [-)_-_ C= Ky CPU Reset Ctri+Fs
¥

Restart
Step in
| Reset CPU
Run without
S|k Restart (reset go) ’
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13. Difference in MCU Operation during a Break (Peripheral Break Function)

While timers and serial communication interfaces in the R8C/M16C continue to operate
while CPU breaks in execution by the emulator, CubeSuite+ for the RL78 allows you to
use the [Debug Tool Settings] sheet to select whether or not those modules are to be
stopped while CPU breaks.

gt CubeSuite+

Embedded
Workshop4

22 BL78 E1iSeriall Property
: : ] E Memory
StartfStop Function Setting A

temaory mappings [9]
[ The specified outine is executed immediately before = fenily onwiing Ao LISy - es
exaculion of tha usar's program, Access Memory While Running
Access by stopping execution [[a]
starting address J J Update display during the execution v'as
Display update intervallms) 500
E Break
[T The specified routing is executed immediataly after First using type of breakpoint Software break
the stop ofthe user's program. Stop emulation of timer group when stopping Yes
Stap emulation of serial group when stopping Yes
starting qddressl -] J = ernputﬁignal
Mask TARGET RESET signal o
bask INTERMNAL RESET signal Mo

| QI I Concel |

In the case of HEW for the RBC/M16C,

you need to use the Start/Stop functions to
create and embed code that will stop the
peripheral modules if this is required.

(R8C/5x series have the Peripheral Break
Function) /

| Selectable on CubeSuite+ for the RL78 |

First using type of breakpoint

Specifies the type of the breakpoint to be preferentially used when setting breakpoints for execution source ar
execution address.

\: Debug Tool Settings : |

- Connect Setting

owrload Fle Setings | Hook Transaction Settings /|




14. Viewing/Changing Memory Data and Variables While the

Program Is Running

To view or change memory data and variables while the program is running in
CubeSuite+, make settings on the [Property] panel by using the following procedure:

(1) Open the [Debug Tool Settings] sheet on the [Property] panel of the debug tool.
(2) Set [Access by stopping execution] in the [Access Memory While Running] field to
[Yes]. Memory data and variables can be viewed while the program is running.

CubeSuite+

= RL78 E1(Serial) Froperty

B Memory
bemory mappings [9]
“erify on writing to memary YEs

Access Memory While Bunning

Access by stopping execution Yes
L= Ul [_IIE.}J' LLTITg e 2L LU =
Display update interval[ms] a00
E Break
First using type of breakpaoint Software break

Stop emulation of timer group when stopping Yes

Stop emulation of serial group when stopping  Yes
B Maskfor Input Signal

tMask TARGET RESET signal [ [a

Mask INTERNAL RESET signal Mo

Access by stopping execution

Specifies whether to access a memory area by momentariky stopping
areathat cannot be access i tian....

Change this to [Yes]. ]

If [NO] is selected, “**” is displayed
on the memory panel while the
program is running.




15. Automatically Updating Memory Data and Variables While
the Program Is Running

To automatically update memory data and variables via CubeSuite+, make settings on
the [Property] panel by using the following procedure:
(1) Open the [Debug Tool Settings] sheet on the [Propertiy] panel of the debug tool.

(2) Set [Access by stopping execution] and [Update display during execution] in the
[Access Memory While Running] field to [Yes].

Information displayed on the memory and watch panels is automatically updated while
the program is running.

To change the update interval, modify the [Display update interval] value.
CubeSuite+ Change two items to [Y@
=% RL78 E1(Serial) Froperty

E Memory
bMemory mappings

B | @ | %, ] 3 | Notation- ||be

; e Wat ch Walus Type Byt
Yarify on writing to memory _
= :
I v stopping execution
Update display during the execution £
Display update intervallms] a00
= Break — | Set update interval.
First using twpe of breakpaint Software break

Variables registered in the watch panel
and memory data in the memory panel
are automatically updated while the

program is running.

Access by stopping execution
Specifies whether to access a memaory area by momentarily stapping exe

areathat cannot be W..

, Connect SetingsS,_Debug Tool Settings_s
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16. Setting Breakpoints

(1) You can set breakpoints in the main area (enclosed by a red line in the figure

below) on the editor panel of CubeSuite+.
Set break points: Single-clicking a line with an address.

Delete break points: Single-clicking a line for which a breakpoint has been set.

CubeSuite+

j inkprg.c jEQT.:: L'Lﬂz_].ﬁ.nalysis Chartl B3 Property 'j'resetprg.c - X
47 ELEFATT0 z = =
4B
49 }

50 £f£fa78a — change (&) ;

51 Cfffa78E ’ - q

52

i . | _ Click here.

54 L£EfEF8759e void sort (long *a)

55 i

=1 long Tt

57 int i, Jj, k, gap:

58

g £fffa7a3 gap = 5;

a0 Lfffa37ak while{ gap > 0 }{

gl Tf£fa7bz fori{ k=0: k<gap! k++){

22 Lfffa7c3 for{ i=k+gap:; 1i<10; i=i+gap ) {

&3 £f££a747 forij=i-gap: J>=k:r 3=3-

&4 ffffa7ea if{alil>ali+gar—

&5 Lfffaansg Tt = al:

1 Lfffafle al[j] =

&7 £fffa83l1 a[j+gar

B

89 else w
= >




16. Setting Breakpoints

(2) Select a breakpoint type (software break or hardware break) for [First using
type of breakpoint] in the [Debug Tool Settings] sheet on the [Property] panel.
(Software break is selected in the example below.)

CubeSuite+s | £ RL78 E1(Serial) Property

B Memory

kemory mappings 9]
Serify an writing to memaory Y'es

B Access Memory While Running
Access by stopping execution Mo
Update display during the execution Yes
Display update interval[ms] a00

=

First u‘sing type of hreakpoint Software break — J\/ i

— e T T e T S T T S e s Set a breaprInt type to
Stop emulation of serial group when stopping Yes 3

S e be preferentially used.

bask TARGET RESET signal Mo
bask INTERNAL RESET signal Mo

First using type of breakpoint
Specifies the type of the breakpaint to be preferentially used when setting br
execution address.

- o
. Connect Settings G .

(3) If the number of breakpoints of the selected type exceeds the limit, the other
type of breakpoints are used.

Event marks indicate the types of breakpoints.

171 Software break : Hardware break

Download File Setfings




16. Setting Breakpoints

(4) You can check the breakpoint setting on the [Events] panel.
Select [View] -> [Event] from the CubeSuite+ menu to open the [Events] panel.
Unnecessary breakpoints can be deleted or disabled on the [Events] panel.

CubeSuite+

X || | |l | B | S| 5] B 5 8

Marne Detail Cary
EER Break0001 Before_Execution fitimEFiUSEF.CI

Iv




17. Causing a Break on Access to a Variable

You can use the watch or editor panel to make a setting to cause a break on
access to a specific variable.

(1) On the watch or editor panel, right-click the variable that you want to set a
break when it is accessed.

(2) Select [Access Break] (or [Break Settings] on the editor panel) and select
[Set Read Combination Break to], [Set Write Combination Break to], or [Set R/W

Combination Break to].
Right-click the variable
to open a pop-up menu.

CubeSuite+

E @ L U] X | notation-

Wat.ch

Select [Access Break]i

@J ead Combination Bre &——< | Access Break
/ ngn
Set Write Combination Break to SeleCt a break Cond|t|0n
W Combination Br Timer Settings . I @ad, Write, or read/WI'ite).

30 RENESAS




17. Causing a Break on Access to a Variable

(3) Enter a value to set a data condition (or leave the box blank if no data
condition is needed).

Enter a data condition
CubeSuite+ if necessary.
@ﬂ Set Read Combination Breal ko ( 10 )/ Access Break 3
Af; Set Write Combination Break ko Trace Cukpuk »
@E‘T et Bw Combination Break to Timer Setkings 3

Note: Enter a decimal number here. When entering a hexadecimal number, add “0x” to
the head (e.g. OxAA).




18. Filling Memory

Memory can be filled (batch change) by using the [Memory Initialize] dialog box.

(1) Right-click on the [Memory] panel to open a pop-up menu, and select [Fill] from the
pop-up menu.

(2) The [Memory Initialize] dialog box opens. Enter addresses (start address and end
address) and initialization data, and then click the [OK] button.

CubeSuite+ Right-click here to open a po@ Enter a start address, end address,

menu and selet [Fill]. and initialization data.

This example shows filling 0x0000
to OXOFFF with OxAA.

@ @ Motation= | Size Motation=  Enc

/
[] Mowve when Stop /
+0 +1 +2 +3 +4 15 46 §  F+9 +a +b tcA

00000000 | OF Ak FF ED(2E 3E 73/ /BF 74 35 ZF|61— Memory Initialize

1 s s
00000020 | a4 4& DF anlac |M | Start addresz/spmbal: IEnd addresz/spmbal:
00000030 | 48 15 AL E7|6C | ap gy ctisE | 00000 . ID:.;fff v
0ooo0040 | 70 04 ES BA|4A T
00000050 | FA 26 Bl SE|09 I|"ﬁ Fill.. I ntialze data:
00000080 | 47 &8 SE EE|CD : HEH | (g v

noo00o0o070 | 08 AC 54 EE|6E | |21 Refresh 1
oooooos0 | 02 51 F7? OES|AS 1 g K 2 | Cancel | | Help
00000090 | ©9 ES FD 739D | :

£ 1=

Note: Enter decimal numbers here. When entering hexadecimal numbers, add “0x” to
the head of each number.
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19. Saving Memory Data

[Data Save] dialog box is used to save memory data.

Select [Debug] -> [Upload...] from the menu.
The [Data Save] dialog box opens. Specify the file name, type, and range of
memory data you want to save, and then click the [Save] button.

CubeSuite+

Enter the name of a file to be saved.

File Mame: |C'Documents and Settingsitoaolgi REMNESAS-LEELZKFWy Dacum  [»] +

File Type: |Motorola S-format (*.mot) v SpeCIfy a flle type (Intel
Save Range Address/Symbaol: HeX MotorOIa S or blnary)
OxfffE000 v | | v _

Specify a memory range. |

Gl [

Note: Enter decimal numbers here. When entering hexadecimal numbers, add “0x” to
the head of each number.
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20. Flash Self-Programming

The RL78 supports a self-programming feature for the rewriting of data in flash
memory by user programs. This is accomplished for user applications by using the
self-programming library for the RL78.

CubeSuitet

High-performance

Embedded i T#QB-ng'ammer (Flzch Fh'o!!!

Workshop# g |E __i " VI e
In the case of HEW for the R8C/M16C, you S U@ rerove fonroet shitooel | ] Addlew ..

. . . { e i [ idd New Caceqory
essentially need to place the debugger in a special ok

mode and create a flash-rewriting program.

hMode (" Erase Flash and Connect

(" Keep Flash and Connect

" Program Flash

g o Debugging of CPU rewrite mode ;
Flazh memar " D‘Jm
= FILL lash memary to PC RBING1S
gvhchronization

My;;%:ﬂa
\,£ Fike garmes “| | ren . 4

In the case of CubeSuite+ for the RL78, on the other hand, e 8 [ ceed ]
you need to install the self-programming library (provided -
for free) in the project. To add the flash self-programming file, right-click
For details on how to install the library, visit the following on [File] in [Project Tree] on CubeSuite+ and
URL:http://www.renesas.com/products/tools/flash select [Add -> Add File ] from the list, then click on
prom_programming/flash_libraries/index.jsp 1t°ir|1: t[;;fs of type] pull-down menu and select the
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21. How to program to check Operation on the Stand-Alone
MCU

If you wish to check operation on the RL78 MCU as a stand-alone device after debugging, use

the Renesas Flash Programmer (flash programming software) to program the data to the flash
memory instead of using CubeSuite+.

.?: Renesas Flash Programmer (Basic mode)

4 ,__‘__,-"'R Az  Mcroconooker  Hep
Emg:rbm:';m e Microcontraller.  [REFICOLE

Wolkesa Frozram Fils FLPE G132 Tutonal_Bazic Dperotion hex Firmesse

In the case of HEW for the R8C/M16C, you need to Pelneid A
select the mode that is suitable for debugging and
also equivalent to the on-chip programmer. Start
hMode (" Erase Flash and Connect PASS
"~ KeepFlash and Connect Eg; %
0%
@rugram Flash ) 532
(" Debugging of CPL rewtite mode éﬁi
(T AglopocedieelE. ) A55
EnzAuoo-ocadure E.7))
---------- [DizCornE] =e===e===-
In the case of the RL78, on the other Sl i el
hand, you need to use the Renesas
’ : The Renesas Flash Programmer is software that
Flash Programmer instead of : 9
: is used to program to the flash memory of
CubeSuite+. . .
Renesas MCUs and is specialized for easy

operation and functionality for programming.
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Useful features of CubeSuite+

22. Action Event (Printf Event)

CubeSuite+ allows the setting of a Printf event as an action event.

A Printf event is used to stop the program momentarily at a specified address and make
software execute the printf command. When a Printf event is set in the [Action Event]
dialog box, the program stops before execution of the instruction at the address where
the event is set, and CubeSuite+ outputs the value of the variables to the [Output] panel.

CubeSuite+

by (V) E1 OULreg = Inreg LIS
10 0019 PE. 2 = putreg:
7 P6.3 = inreg: S PR
72 001ab % . g count++, @ W Start build(RL7S_&13 Tutoriasl Easic Opera A_
13 = /= End user code. Do not edit comment generated here =/ tion, DefaultBuild) ------ Al
74 D{]]‘E ]- —————— Build ended(Error:0, Warning:0) ------ (J
15 ========== Ended [Success:1 Projects, Failed:0 Pr
‘ ojects) (Thursday, July 26, 2012 3:47:41 PM) ====
To insert code that is equivalent to j=====A
printf(“Sample: g_count = %d, P6 = %d¥n",g_count,P6) Semple;o_count=1(0x0001), P6=0x8 [DxD8]] \
. . Sample;qg count=2 (0x0002), PE=0x4 [D:-:DQIIJ
_at this address _-> Set an action event. Sewple; g count=3 (0x0003), FE=OxE [0x08} |
r E 1 Sample;g count=4 (0x0004), PE=D:-:*'«1[D:-:D‘1:I(J
Action Events Semple; g count=5(0x0005), PE=0x8 (0x08) | L

P if t-l Sample;q count=6 (0x0006) , PE=EI:-:4[EI:-:EI4:I(J
L Sample;gq_count=7(0x0007), PE=0x8 (0x08) ]

ST ST, \g(mple) Sample: / Sample; g count=8 (0x0008) , P6=0x4 EDKD"‘”.{J
(= Semple;g_count=0(0x0009), PE=0x8 (0x08},| /
[ !Sample; / Stopped by SOltware Break.]

_ = The result is output [EOF]
Yarahle expression: Mbb, CCC tO the [Output] panel_
|

\g_count,PB \ All Messages | *Build Tool | *Debug Tool /

\g.d.d.r.eaa'_/ -
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Useful features of CubeSuite+

23. Viewing Lists of Variables and Functions

CubeSuite+ can automatically display lists of variables and functions used in
the project.

Select [View -> Program Analyzer] from the menu.
CubeSuite+

Frogram Analyzer P Function List

&~ Wariable List
e Analysis Chart

% Show Current PC Location  Cirl+L

= Back to Last Cursor Position

v
Function List ]
I T B | @mg B £ FT | UnitofTime -
|-_=-|‘|* A pelopbloieatty  File Mame ¥ Afirbute W8 FRetumn Type ? Arguments W
i e e ——. 8 0 CGC Create |t iFar woid wnid
U2 varisble Mome 7+ FileName ¥R  Attdbule ¥R Type ¥R s — —
e B el taR e et z | R:PGRT_create rlport.c far waid woid
r_timar_user_c: i) e e B_TAUD _Create  rftimer.c for i i
r_ﬂmer_.ujifar I [IER: double @ R_TAUD _Chann,. rjtimer.c far woid woid
(N? il = = RB_TAUD Chann.. rjtimer.c far winid wioid
EHmEr_Lisar.c i =% H_TAUD Chann... rjtimer_user.c intarrupt woid woid
% =% main rimain. c far wiid woid
= F_Swsieminit risysteminit.c far wiid woid
> hichwvinit systeminil.c far i wiid
<w [ (Mo Definition) - - -
/ 2w FI fNn Nsfinifion) - 8 = bt
£ | *

Clicking on a variable or function name opens the corresponding source file.
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24. Analytical Graphs

CubeSuite+ has an analytical graphing feature, which shows line graphs indicating the
relationships between the values of variables, registers, and addresses and time.

The graphs shown by CubeSuite+ during on-chip debugging of the RL78 are based on
data acquired through the pseudo-RRM function.

CubeSuite+

Useful features of CubeSuite+

Graph control area ’

Analysiz method: @9 Sampling

Samphng FReflect o vt 1 S|

Trgoer; &uto,  chl: Ol[Fising] Fosition

i { Trigger W
—m

TirmeDiv: 3

p Cursor A

Cursor B

33:248ms

Cursar;
() ¥ ams (Time)

@) awis (Walue

: Targst

Time;
chl:
chi:
chid
chd:
ch:
chib:
chi:
chi
cha:

| (M)

)

Curgor-..

\+ Variable Value Changing Chart |7

“al/Div: 3.6 Wal/Di: 2.0

chs chi:
“EecLiton Tme(eercentage) Chare. |

/lkf )
/

| ER / ch2:
E 4_caunt E i

cha:

[rnane)

“al/Div: 25.5

ch7:

ch4:
(none)
WaliDiv: 2

chi:

5.5

Cursor
information area

Channel
information area
S
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25. Debugging Functions of Emulators (OCD)

Debugging Function RL78 (E1/E20) R8C (E8a/E1/E20) M16C (E8a)
Breaks Software breaks 2000 points 255 points 255 points
Hardware breaks 1 to 2 points shared between 2 to 10 points shared between 6 to 10 points shared between
instruction-execution and access [ instruction-execution and access instruction-execution and
events* events* access events*
Forced breaks Supported Supported Supported
Events Number of event 1 to 2 points shared between 1 to 2 points™ 0 to 2 points*
points instruction-execution and access
events®
Usage of events For hardware breaks only For hardware breaks only For hardware breaks only
Tracing Branch trace* Branch trace/Data trace* Branch trace/Data trace*®
Performance Measurement item From the start to the end of From the start to the end of From the start to the end of
measurement execution execution execution
Performance Resolution: 100 us E8a Resolution: 1 ms Resolution: 1 ms
Measurement time: Up to 100 Note: A timer in the host machine | Note: A timer in the host
hours is required as a resource. machine is required as a
E1/E20 Resolution: 1 us resource.

Pseudo realtime RAM monitor (RRM)

Supported: the CPU is occupied
during monitoring.

Supported: the CPU is occupied
during monitoring. / Debug DMA

Supported: the CPU is
occupied during monitoring. /
Debug DMA

Dynamic memory modification (DMM)

Supported: the CPU is occupied
during modification.

Supported: the CPU is occupied
during modification./

Supported: the CPU is
occupied during modification. /

Debug DMA Debug DMA
Hot plug-in Not supported Not supported Not supported
Security Authentication of 10-byte ID** Authentication of 2- or 4-byte ID** | Authentication of 4-byte ID**

Number of pins taken up

1 (TOOLO)

1 (MODE)

1or2or7

Peripheral breaks

* Varies with the MCU.

** For details on differences in specifications of the ID code, refer to 4. Entering an ID Code in this document.
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Supported

Not supported
(R8C/5x: Supported)

Not supported
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